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Madhav Sukumaran, under the 
guidance of Dr. Chris J. McBain 
(NICHD) and Dr. Ingo H. 
Greger (Cambridge University), 
studies AMPA receptor 
assembly and dynamics at the 
atomic level. 

Meet the 2012 NGSRA Winners 

Some of the more recent NICHD trainees are making big strides. Graduate 
students Madhav Sukumaran and Mark Ziats received the 2012 NIH Graduate 
Student Research Award (NGSRA) at the 8th Graduate Student Research 
Symposium on January 11, 2012. Both Madhav and Mark joined the NICHD 
as students at Cambridge University through the NIH Graduate Partnership 
Program. In honor of their achievements, The NICHD Connection invited them 
to discuss their studies:

Neurons communicate at junctions, called 
synapses, where chemical messages bind to 
specialized receptor proteins on the receiving 
neuron’s membrane, initiating an electrical 
response. One receptor subtype (the AMPA-
type glutamate receptor) is responsible for 
fast, point-to-point communication between 
neurons. Using high-resolution biophysical, 
electrophysiological, and crystallographic 
assays, we investigated the role of the AMPA 
receptor N-terminal domain (NTD), a 
section of the protein that was previously 
implicated in receptor assembly. We showed 
that the NTD plays an organizing role in the 
initial assembly steps and identified which 
NTD components controlled the assembly 
process. Not all AMPA receptor assemblies 
are created equal, so we explored the 
physiological and pathological conditions that 
create favorable and unfavorable receptor 
populations. Our investigations of the NTD 

molecular architecture revealed that the N-terminal domain might be more 
dynamic than previously thought. We also found that the N-terminal domain 
may have an additional role in the neuron: directly regulating receptor electrical 
function through potentially novel mechanisms.  

(continued on page 2)
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(continued from page 1)

Autism is known to be highly genetic, but the heritability is complex 
and the underlying molecular mechanism(s) remain unknown.  To date, 
genetics studies in autism have focused on regions of DNA that make 
protein—but this represents less than 5% of the genome.  We looked 
at differences in the expression of RNAs from regions of the genome 
that do not make protein (termed long non-coding RNAs or lncRNAs), 
because they are known to be involved in many fundamental genome 
regulatory processes.  By assessing post-mortem brain tissue from autism 
patients versus normal controls, we discovered over 200 lncRNAs 
differentially expressed in autism and showed these are highly enriched 
for regions nearby genes involved in processes that are aberrant in 
autism.  Additionally, when we compared lncRNA expression within 
two regions of the brain from a single individual, we discovered that the 
expression of lncRNAs is less complex within autism brains as compared 
to controls.  This had previously been reported for mRNAs, and our 
results extend these findings to suggest that less complex transcriptional 
regulation in general may be a molecular mechanism underlying autism.  
We are currently following up this work by studying the network-biology 
effect of a subset of these lncRNAs in neuronal cultures.

Letter from the Editor

If you didn’t get a chance to read last month’s issue, 
visit newsletter.nichd.nih.gov and download it from 
the archives, because this month we have Part II for 
both “How to Wiki,” by Nichole Swan, and “How 
to Write a Personal Statement that Pops,” by 
Heather Dolan.  

The remainder of this issue is devoted to great 
announcements. Congratulations are in order for 
Madhav Sukumaran and Mark Ziats, the NICHD 
recipients of the NIH Graduate Student Research 
Awards. You will find their research summaries 
on page 1. In addition, I am very excited to 
announce that the NICHD Annual Retreat Steering 

Committee has released the keynote speaker 
line-up for the 8th Annual Fellows Retreat in May. 
Curious who they speakers will be? Find out on 
page 10! You will not be disappointed.

The NICHD Connection is a fun way to share 
your personal announcements too. If you have 
a photograph of something fun, exciting, or 
interesting, please send it to Shana.Spindler@gmail.
com for inclusion in our “Life Outside Lab” column. 

Your Editor in Chief,
Shana R. Spindler, PhD

Meet the 2012 NGSRA Winners 

Mark Ziats, under the 
guidance of Dr. Owen Rennert 
(NICHD) and Dr. Azim Surani 
(Cambridge University), studies 
long non-coding RNAs in the 
autistic brain.
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How to Wiki, Part Two: Editing
By Nichole Swan

Hello again!  Last month I showed you how to set up your wiki space, so if you missed 
out on that, please go back and check it out!  In this installment of “How to Wiki,” I’m 
going to give you an overview of some of the cool advanced capabilities of the wiki.

To begin editing your wiki, either go to a page you’ve already created or create a new 
one, then click on “Edit” and then “Edit this page.”
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By default, you will be in “Rich Text” mode.  Many 
of the buttons will hopefully be familiar to you from 
other programs such as Word, or any rich text email 
program.

2
There are a few differences, though:  
for example, the “Insert” dropdown 
menu. I won’t go over all of these; let’s 
just focus on macros.

Macros are little 
snippets of text inside 
of {curly brackets} that 
generate something 
more complex--kind 
of like shortcuts.

There are two 
buttons that bring up 
the Macro Browser; 
one is in the “Insert” 
dropdown menu, and 
the other is in the 
main row of buttons.  
Just look for the 
“magic scroll” icon!

3 You can also bring up macros by typing in Rich 
Text mode. Just start with a curly bracket ({) 
and macro suggestions will automatically pop 
up.

To give you 
an example 
of how 
macros work, 
let’s try the 
{cheese} 
macro.  
When we 
save the page, the macro gives us...

(continued on page 4)

WHILE WE DON’T WANT TO BE 
THE WIKI POLICE, it’s important 
that we remind our users to refrain from 
posting patient data or other personally 
identifiable information.  Also, as this is a 
professional, government setting (even on 
the web), we discourage uploading personal 
images, such as pictures of your children.



(continued from page 3)
How to Wiki

4
...this!

5
But let’s try something you’re more likely to 
use. ☺ The {gallery} 
macro is perfect for 
displaying images, such 
as those you’ve created 
or generated in your 
research.

You can find it in the 
Macro Browser, or you 
can select “Gallery” 
from the “Insert” 
dropdown menu. First 
we’ll need to attach 
some images to display.

Don’t worry about 
saving the page for 
now; go back up to the 
Edit menu and select 
“Attachments.”

6

Attaching files to the wiki is just like 
attaching them to an email.  You have 
the option of adding a comment for 
each file, which will act as an image’s 
caption when displayed with the 
{gallery} macro.

You can also attach multiple files at 
once, up to 25. Choose a few images 
and click the “Attach” button at the 
bottom when you’re done.

7 Going back to edit our page (“Edit” 
→ “Edit this page”), you can now 
pick the {gallery} macro out of the 
Macro Browser again.

The browser gives you a preview 
as well as all of the options for the 
macro.  I’ve chosen to sort them 
by file name, and I’ve also given my 
gallery a title.

When you’re finished, click “Insert.”

4
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(continued on page 5)



(continued from page 4)
How to Wiki

8 In Rich Text mode, your macro will look like this:

9
Save your page.  Now you 
have a nice little gallery to 
display your images!  Click on 
each image to expand it.

10
I can also display my 
attachments using the 
{attachments} macro.  
This is useful when you 
have files other than 
images that you want 
to post to your wiki, 
such as PDFs and Word 
documents.

Create a new page (such as “Publications”--if you have it listed in your sidebar, you can just click 
the link and save it as a blank page).

Like we did before, go to the “Edit” menu and click on “Attachments.” Upload a few PDFs or 
Word document, and return to editing the page (“Edit” → “Edit this page”).

In the Macros Browser, search for “attachments.” Configure it the way you want it, click “Insert,” 
and save the page. The macro has generated a list with information about all of your files.

5
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(continued on page 6)



(continued from page 5)
How to Wiki

11

These are just a few of the 
many macros you’ll find on 
the wiki.  Now that you have 
an idea of how they work, 
feel free to play around and 
experiment with them.

12

You may have noticed a tab at the top, above the 
Rich Text button, labeled “Wiki Markup.” This is 
a text-only way of creating page content.  It might 
look daunting, but it’s actually quite simple.  We’ve 
provided a cheat sheet in the right side bar, if you’re 
feeling adventurous and would like to give it a try.  
While editing a page, just click on the little black 
arrow on the right, which will expand the sidebar.

When not editing the page, the right sidebar will 
display links to helpful pages such as the site map, 
attachments index, and user preferences.

You can click the little black arrow again to hide the 
sidebar.

13
Lastly, it’s important to keep your 
pages organized.  By clicking on the 
aforementioned “site map” link in 
the right sidebar (or by going to 
“View,” then “Other pages,” then 
“Site map”), you can easily rearrange 
the hierarchy of your wiki pages by 
dragging and dropping.  I recommend 
keeping all of your content 
nested under “Home,” and your 
“Navigation” and “Header” pages 
outside of the hierarchy altogether.
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(continued on page 7)



(continued from page 6)
How to Wiki

Hopefully that wasn’t information overload!  Ultimately, the 
wiki exists for you: without users, it can’t grow and thrive.  
It might look daunting, but think of it as an experiment!  
We wholeheartedly encourage you to play around, make 
mistakes, and see what the wiki can do.  Just remember that 
you can email Jeremy Swan (swanjere@mail.nih.gov) or me 
(jonasnic@mail.nih.gov) with any questions.  

Next time I’ll show you how to customize the look of your 
wiki.  Until then, good luck and have fun!

DON’T BE NERVOUS!
The wiki saves a version history of your 
pages (and attachments), so any mistakes are 
completely reversible.  You can 
access a particular page’s history 
by going to “View,” then “This 
page,” then “Page information.”  
Once there, you can click on the 
“View Page History” link to the 
right of the page.

7
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MORE MACRO RESOURCES:
» Our wiki’s Demonstration Space:
https://science.nichd.nih.gov/confluence/display/ds/Confluence+Overview

» Confluence User Guide, Working with Macros:
http://confluence.atlassian.com/display/DOC/Working+with+Macros

» Adaptavist Macro Guide:
https://www.adaptavist.com/display/AtlassianConfluence/Macros

» Please note that not all macros listed on these pages are installed on our 
wiki.  If there’s a macro we don’t have that you would like us to implement, 
please let Jeremy (swanjere@mail.nih.gov) or me (jonasnic@mail.nih.gov) 
know, and we’ll see what we can do. 

end
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How to Write a Personal Statement that Pops: Part II
By NIH postbacs
Compiled by Heather Dolan

Personal statements are a critical component 
to any medical or academic application. In 
the personal statement, the applicant has the 
opportunity to present those aspects of him 
or herself that cannot be found in a CV, test 
score, or academic transcript. But how does 
one craft a perfect personal statement that 
captures the applicant’s strengths and desires 
without sounding fake or inflated? In the January 
issue of The NICHD Connection, professional 
advisors offered tips about writing a winning 
personal statement. This month, fellow postbacs 
present extra advice based on their personal 
experiences. They discuss pre-writing ideas, the 
writing process, personal statement content, and 
editing. 

THE PRE-WRITING PROCESS 
“Think about why you want to go to medical 
school based on what you enjoy about each of 
your research or clinical experiences. Then, think 
about what you learned from each one and how 
you could use that knowledge and experience 
to be a better medical student and eventually 
physician. Do all of this over the span of months 
so you have time to really reflect rather than 
trying to develop a half-baked idea that hasn’t 
had time to fully develop.”

“Decide if you are going to be heartfelt or 
humorous: this will determine the tone for the 
rest of the statement.” 

“If you’re shy or abhor self-promotion, ask family, 

friends, and acquaintances how they would 
describe you (and don’t take it personally).” 

THE WRITING PROCESS 
“Write a core statement first. Then, get feedback 
from mentors and others before proceeding to 
write the actual personal statement.”

“If you are having trouble adding to the 
statement, an English class TA told me this 
equation: ICE - introduce, cite, and explain.”

“Be cohesive! Don’t write individual paragraphs 
about things you’ve done and then stack them 
on top of each other. Although you talk about 
different experiences, the statement needs to be 
one coherent story that ties everything back to 
you!”

PERSONAL STATEMENT CONTENT 
“Don’t miss the point: you are trying to tell them 
why you want to go to med school. If you feel 
like that point is getting lost in your story, stop 
and refocus. It’s not the worst thing to write: I 
want to go to medical school because. . . .”

“Don’t restate anything that the admissions 
people can find elsewhere in your application  - 
you are wasting valuable space! Instead, APPLY 
what you have done - talk about how it spurred 
your interest in what you want to learn next, 
your future career goals, and so on.” 

“Focus on only a few research or volunteer 

(continued on page 9)
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How to Write a Personal Statement that Pops: Part II
(continued from page 8)

experiences and describe your personal 
contribution. Instead of listing your duties, write 
about specific events. It makes a more compelling 
personal statement to write about a few things 
you are enthusiastic about, rather than to create 
a laundry list of all the volunteer, research, and 
clinical experiences you have had.” 

“You may not be a very exciting person, have 
any life-transforming experiences, or have gone 
through any extreme personal challenges. In 
short, you’re a pretty typical candidate. To make 
your statement more than ‘I like science and I like 
helping people,’ write about your experiences. 
Why do you want to be a doctor? Nobody is 
born with such impulses, so where do they come 
from? What have you done to learn about the 
medical profession? What do you like about 
the profession? Once you get a list of answers 
to these questions, you can start assembling 
and tying them together. Although no one part 
is particularly standout, when they are strung 
together they paint a picture of you that is 

personal and accurate.”

THE EDITING PROCESS 
“Have many people read your personal statement. 
You don’t necessarily have to incorporate all the 
changes suggested by readers, but having input 
from a variety of people can be helpful in shaping 
your personal statement.“ 

“NIH-ers tend to throw around a lot of 
acronyms, so have someone not affiliated with 
NIH read your statement and tell you if it is 
comprehensible.”

“Don’t worry too much about the character limit 
at first. The best way to have a well-written essay 
is to edit extensively. My essay started at almost 
twice the character limit. By continuously editing 
and cutting things out my writing was better 
and my essay didn’t have any of the fluff that I 
unconsciously put in initially.”
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Annual Retreat Keynote Speakers Revealed
By Shana R . Spindler, PhD

In just a few months, we will be sitting in the beautiful Airlie Conference Center (subject to 
official review, in process at time of writing) anxiously awaiting the insightful words of the 
8th Annual NICHD Fellows Retreat keynote speakers. We will have the honor of hearing 
from the renowned Director of the Whitehead Institute, Dr. David Page, and the always-
entertaining scientist and writer, Dr. John Bohannon. To whet your appetite, here’s a little 
information about our esteemed guests: 

DAVID PAGE, MD (http://www.wi.mit.edu/research/faculty/page.html)
If you are a male, Dr. David Page may know more about your Y chromosome 
than anyone else in the world. And don’t worry ladies; Page’s investigations haven’t 
ignored the X chromosome. In fact, he was the first person to discover that the sex 
chromosomes are evolutionary products of what were once two autosomes. Page 
has studied the Y chromosome for nearly his entire medical career. As a young college 
graduate with the “research bug,” Page joined the Harvard-MIT Division of Health 
Sciences and Technology M.D. program, which allowed him to do research while 
receiving his medical degree. Through the program, he discovered not only his love 
for medicine, but also his attraction to laboratory experiments and his fascination with 
the mysteries of DNA, which would set the stage for the rest of his scientific career. 
Page is currently the Director of the Whitehead Institute, Professor of Biology at the 
Massachusetts Institute of Technology, and Investigator of the Howard Hughes Medical 
Institute. But perhaps he is best known as the leading expert on Y chromosome 
sequence, gene composition, evolution, recombinant potential, and relation to disease 
and infertility. 

JOHN BOHANNON, PHD (http://www.johnbohannon.org)
In that fantastic place where science meets art and culture, you will find Dr. John 
Bohannon, otherwise known as the Gonzo Scientist. Bohannon is the creator of 
Dance Your Ph.D. Contest, co-writer of Green Porno, and mastermind behind the 
Science Hall of Fame. Bohannon began his adventures in science with his doctoral 
degree in molecular biology, which on his website he claims is a result of following a 
girl to Oxford. Bohannon then studied bioethics in Berlin as a Fulbright scholar. He has 
subsequently become a visiting researcher at Harvard University, where he examines 
the ethical facets of science and public health policy. After embedding with military 
forces in Afghanistan, Bohannon organized the first release of civilian casualty data by 
the military and the United Nations. Throughout Bohannon’s journeys, he has served 
as a correspondent for Science magazine. There he maintains, among other writings, 
the Gonzo Scientist, a column that explores—and actively experiments with—the 
intersection between science and culture. To watch Bohannon use the arts to portray a 
complex problem, check out his latest TEDxBrussels talk.

Don’t miss your chance to meet Dr. Page and Dr. Bohannon! Mark your calendars now for 
the NICHD annual fellows retreat on May 7 and 8, 2012!
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February Announcements

CONGRATULATIONS TO NICHD STAFF AWARD RECIPIENTS
Congratulations to the following individuals for their recognition at the 2012 NICHD Staff Awards 
Ceremony held on January 18, 2012. Staff members with their respective awards: 

» Drs. Chris McBain and Meg Keil, National Institutes of Health Awards of Merit 
» Drs. Mark Stopfer and Tamas Balla, NICHD Mentor Awards
» Dr. Alicia Armstrong, NICHD Collaboration Award
» Administrator Becky Preston, NICHD Mentor Award 
» Administrators Ann Fox and Valerie Leftwood, Group NICHD Mentor Award

SAVE THE DATE! 8TH ANNUAL FELLOWS RETREAT MAY 7 & 8 , 2012 .  
The 8th Annual Meeting of NICHD Postdoctoral, Clinical, and Visiting Fellows and Graduate 
Students will be held May 7-8, 2012. This is a not-to-be-missed event, so please be sure to mark 
your calendars! For a sneak peak at the key speaker line-up, please see page 10 of this issue. For 
more information, contact Brenda Hanning at hanningb@mail.nih.gov.

CALLING ALL FELLOWS OF NICHD—IT’S IMAGE COMPETITION TIME! 
The 8th Annual NICHD Fellows Retreat will be held in May 2012, and we would like one of you 
lovely people to supply us with an image that represents some of the work done by us here at 
NICHD. 

Do you have an image of your science that you would like us to use as the image for this year’s 
retreat? The winning image, chosen by the Retreat Steering Committee, will be showcased on the 
retreat website, on posters, and used as the front cover of the event program. 

All submissions that we receive will be used to produce a gallery of our varied imaging talents on 
the retreat website, so even if yours isn’t chosen as the main image, your work will be displayed. 
Have a look at last year’s submissions here (http://retreat.nichd.nih.gov) and if you think that you 
have something interesting, then send it over (at the highest possible resolution) to Nicki Swan 
(jonasnic@mail.nih.gov).

The deadline for submissions is February 13th. Best of luck!

LAST YEAR’S WINNER:
Preethi Chandran, Section 
on Tissue Biophysics and 
Biomimetics (Peter Basser 
Lab)
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(continued on page 12)
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February Announcements
(continued from page 11)

CONGRATULATIONS TO NICHD NGSRA WINNERS!
Congratulations to Madhav Sukumaran and Mark Ziats, recipients of the 2012 NIH 
Graduate Student Research Awards (NGSRAs). Great job to all Graduate Student 
Research Symposium participants on your posters! Please see page 1 for Madhav’s 
and Mark’s research summaries.

DR. GISELA STORZ RECEIVES GPP OUTSTANDING MENTOR AWARD
Congratulations to Dr. Gisela Storz on her receipt of the Graduate Partnership 
Program Outstanding Mentor Award, presented at the 2012 NIH Graduate Student 
Research Symposium on January 11, 2012. Dr. Storz’s mentees, Maureen Thomason 
and Xuefeng Yin, nominated her for the honor.

February Events

WEDNESDAY, FEBRUARY 15, 12 PM
NICHD Fellows Committee Meeting
1st floor CRC atrium  
Come one, come all!

http://www.phdcomics.com/comics/archive.php?comicid=823
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